Declaration of Conformity

Product: Universal Chromatography Interface
Types: UCI-50 and UCI-100

Dionex Softron GmbH herewith declares conformity of the above products with the respective requirements of the following regulations:

- Low-Voltage Directive 2006/95/EC
- EMC Directive 2004/108/EC

The electrical safety of the products was evaluated based on the following standard:

- EN 61010-1: 2002
  Safety requirements for electrical equipment for measurement, control and laboratory use
  Part 1: General Requirements

The Electromagnetic Compatibility (EMC) of the products was evaluated based on the following standard:

- DIN EN 61326: 2006
  Electrical equipment for measurement, control and laboratory use
  EMC Requirements

This declaration is issued for the manufacturer
Dionex Softron GmbH
Part of Thermo Fisher Scientific Inc.
Dornierstrasse 4
D-82110 Germering

by the President, Dr. Peter Jochum.
November 2, 2011
# Table of Content

1 Introduction ................................................................................................................... 1  
1.1 How to Use this Manual .................................................................................................. 1  
1.2 Safety Information ........................................................................................................ 2  
1.2.1 Symbols on the Module and in the Manual ............................................................ 2  
1.2.2 General Safety Precautions .................................................................................. 3  
1.2.3 Consignes Générales de Sécurité ........................................................................ 3  
1.3 Intended Use .............................................................................................................. 3  
1.4 Federal Communications Commission (FCC) Note .................................................. 3  
2 Overview ........................................................................................................................ 5  
2.1 Unit Description .......................................................................................................... 5  
2.2 UCI Configurations ..................................................................................................... 5  
2.3 Front Panel Elements ................................................................................................. 6  
2.4 Rear Panel .................................................................................................................. 7  
2.4.1 Analog Connectors ............................................................................................... 8  
2.4.2 Digital Inputs ....................................................................................................... 8  
2.4.3 Digital Outputs .................................................................................................... 8  
2.4.4 USB and LAN Ports ............................................................................................. 8  
2.4.5 RS-232 Ports ....................................................................................................... 9  
2.4.6 BCD Inputs ......................................................................................................... 9  
2.4.7 Power Receptacle ............................................................................................... 9  
2.5 Operation with Chromeleon ..................................................................................... 10  
3 Installation ................................................................................................................... 11  
3.1 Facility Requirements .............................................................................................. 11  
3.2 Unpacking ................................................................................................................ 11  
3.3 Connecting and Setting Up the UCI in Chromeleon .................................................... 12  
3.3.1 Connecting the UCI to the Chromeleon Server PC ............................................. 12  
3.3.2 Connecting the UCI to External Devices ............................................................ 12  
3.3.3 USB Installation ............................................................................................... 13  
3.3.4 LAN Installation ............................................................................................... 15  
3.3.4.1 Connecting the UCI through an Instrument LAN (Windows NT4) ................ 16  
3.3.4.2 Separate Network Interface Card .................................................................. 17  
3.3.4.3 Assigning IP Properties (CmlIPUtil) ............................................................ 21  
3.3.4.4 Network Operation .................................................................................. 24  
3.3.5 Setting Up the UCI in Chromeleon ..................................................................... 27  
3.3.5.1 Installing the UCI .................................................................................... 27  
3.3.5.2 Configuring the UCI ................................................................................ 28  
3.3.5.3 Adding more than one UCI to the Server Configuration ............................ 31  
3.3.5.4 Setting Up the Analog Inputs .................................................................. 32  
3.3.5.5 Setting Up the Digital Inputs, BCD Inputs, and Relay Outputs .................. 33  
3.3.5.6 Assigning the RS232-Ports ...................................................................... 35  
3.3.5.7 Commands and Properties in Chromeleon .............................................. 35
4 Troubleshooting .................................................................................................................37

5 Maintenance and Service ...............................................................................................43
  5.1 General Information ...............................................................................................43
  5.2 Updating the UCI Firmware ..................................................................................43

6 Technical Information ....................................................................................................45

7 Accessories and Spare Parts ..........................................................................................47
  7.1 Standard Accessories ............................................................................................47
  7.2 Optional Accessories .............................................................................................47

8 Pin Assignment ................................................................................................................49
  8.1 General Information ...............................................................................................49
  8.2 Analog Inputs ........................................................................................................49
  8.3 Digital Inputs .........................................................................................................50
  8.4 RS-232 Ports ..........................................................................................................51
  8.5 BCD Inputs (Sample Position Recording) ..............................................................52
  8.6 Power Receptacle .................................................................................................53

9 Index ..............................................................................................................................55
1 Introduction

1.1 How to Use this Manual

The layout of this manual is designed to provide quick reference to the sections of interest to the reader. However, in order to obtain a full understanding of the interface, Thermo Fisher Scientific recommends that you review the manual thoroughly before beginning operation.

Almost all descriptions in the manual apply to all types of the Universal Chromatography Interface. Therefore, the term "the UCI" is used throughout the manual. If some detail applies to only one type, the type is identified by name.

Note: The device configuration may vary; therefore, not all descriptions necessarily apply to your particular instrument.

The software descriptions in this manual refer to firmware version 3.03 and Chromeleon™ 6.80 Service Release 11.

This manual is provided "as is." Every effort has been made to supply complete and accurate information and all technical specifications have been developed with the utmost care. The information contained in this manual should not be construed as a commitment by Thermo Fisher Scientific. Thermo Fisher Scientific assumes no responsibility for any errors that may appear in this document. This document is believed to be complete and accurate at the time of publication. In no event shall Thermo Fisher Scientific be liable for incidental or consequential damages in connection with or arising from the use of this document.

The information contained in this document is subject to change without notice.

All rights reserved, including those for photomechanical reproduction and storage on electronic media. No part of this publication may be copied or distributed, transmitted, transcribed, stored in a retrieval system, or transmitted into any human or computer language, in any form or by any means, electronic, mechanical, magnetic, manual, or otherwise, or disclosed to third parties without the express written permission of Thermo Fisher Scientific Inc.

Trademarks
Windows and Windows Vista are registered trademarks of Microsoft Corp.
All other trademarks are property of Thermo Fisher Scientific Inc. and its subsidiaries.
1.2 Safety Information

The CE Mark label on the bottom of the UCI indicates that the module is compliant with the related standards.

1.2.1 Symbols on the Module and in the Manual

The table shows the symbols used on the instrument:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Refer to the Operating Instructions to prevent risk of harm to the operator and to protect the module against damage. Référez-vous à ce manuel pour éviter tout risque de blessure à l'opérateur et/ou protéger le module contre tout dommage.</td>
</tr>
<tr>
<td>🔄再生能源</td>
<td>Label according to the &quot;Measures for Administration of the Pollution Control of Electronic Information Products&quot; (China RoHS) guideline. Étiquette &quot;Measures for Administration of the Pollution Control of Electronic Information Products&quot; (China RoHS)</td>
</tr>
<tr>
<td>☐</td>
<td>WEEE (Waste Electrical and Electronic Equipment) label—For more information, see the WEEE Information section in the &quot;Installation and Qualification Documents for Chromatography Instruments&quot; binder. Étiquette WEEE (Waste Electrical and Electronic Equipment) — Pour plus d'informations, référez-vous au chapitre WEEE Information dans le classeur &quot;Installation and Qualification Documents for Chromatography Instruments&quot;.</td>
</tr>
</tbody>
</table>

At various points throughout the manual, messages of particular importance are indicated by certain symbols:

- **Tip:** Indicates general information, as well as information intended to optimize the performance of the instrument.
- **Important:** Indicates that failure to take note of the accompanying information could cause wrong results or may result in damage to the module.
- **Important:** Indique que ne pas tenir compte de l'information jointe peut conduire à de faux résultat ou endommager l'instrument.
1.2.2 General Safety Precautions

Before initial operation of the UCI, make sure that you are familiar with the contents of this manual.

- Replace faulty power cords and communication cables.
- Use original Dionex spare parts only. Substituting non-Dionex parts or using non-Dionex accessories may impair the performance of the UCI.
- Do not use the UCI in ways other than those described in these operating instructions.

1.2.3 Consignes Générales de Sécurité

Avant de commencer à utiliser l'instrument, assurez-vous que vous vous êtes familiarisés avec le contenu de ce manuel. Observez les étiquettes d'avertissement sur l'appareil et référez-vous aux sections correspondantes dans ce mode d'emploi.

1.3 Intended Use

The UCI is designed to be an interface between the Chromeleon Chromatography Management System and the modules of a chromatographic system.

Please note that the UCI may be operated only by using Dionex accessories and spare parts (→ page 47) and within its technical specifications (→ page 45).

If there is any question regarding appropriate usage, contact Thermo Fisher Scientific before proceeding.

Thermo Fisher Scientific cannot be held liable for any damage, material or otherwise, resulting from inappropriate or improper use of the instrument.

1.4 Federal Communications Commission (FCC) Note

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the U.S. FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the user will be required to correct the interference at his expense.
2 Overview

2.1 Unit Description

In chromatographic systems, the most different interface types are required for data acquisition and device control. The UCI provides these different interfaces and makes them available to the chromatography server. In this way, virtually any chromatography device can be used with Chromleon.

- Chromatographic detectors convert signals, for example, absorption or conductivity, into electric voltage. However, as a computer can process only digital information, electric voltage must be converted into digital data. If the detector itself is not capable of performing this conversion, an analog/digital converter is required. The autoranging A/D with 25-bit dynamic resolution of the UCI provides accurate, reliable measurement of large and small peaks in the same chromatographic run.

- The fast data collection rate (100 Hz) and high channel stability ensure faithful representation of narrow peaks, such as those typical with gas chromatography (GC) and capillary electrophoresis.

- The front panel LEDs visualize the detector signal levels that are currently applied to the analog inputs (voltage levels), the TTL and relay states, and the activity of the computer communication ports.

- Four independent RS-232 interfaces allow simultaneous control of up to four chromatography modules.

- The (16-bit) BCD inputs of the UCI allow BCD-enabled autosamplers to communicate to Chromleon the position of the vial from which the injection was performed.

- Eight potential-free relay outputs and eight TTL inputs support communication with all kinds of chromatography devices.

- Data transmission between the UCI and Chromleon is by using either the integrated USB (Universal Serial Bus) interface or the LAN interface (Ethernet).

- Self-test and automatic online calibration make adjustments and maintenance unnecessary.

2.2 UCI Configurations

The UCI is available in the following configurations:

<table>
<thead>
<tr>
<th>UCI</th>
<th>Description</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>UCI-100</td>
<td>Universal Chromatography Interface, 8 channels</td>
<td>5911.0010</td>
</tr>
<tr>
<td>UCI-50</td>
<td>Universal Chromatography Interface, 2 channels</td>
<td>5911.0005</td>
</tr>
</tbody>
</table>
### 2.3 Front Panel Elements

![Front Panel View](image)

#### Fig. 1: Front panel view (here UCI-100)

<table>
<thead>
<tr>
<th>No.</th>
<th>LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USB</td>
<td>The LED flashes if data is transmitted over the USB connection.</td>
</tr>
<tr>
<td>2</td>
<td>LAN</td>
<td>The LED is on if a LAN connection is established ('good link').</td>
</tr>
<tr>
<td>3</td>
<td>Power</td>
<td>The LED is on if the UCI is connected to the power supply by using the power supply unit.</td>
</tr>
<tr>
<td>4</td>
<td>RS232 Ports</td>
<td>The 'Transmit' LED of an RS-232 port is on (red) if data is sent through this port. The 'Receive' LED of an RS-232 port is on (green) if data is received through this port.</td>
</tr>
<tr>
<td>5</td>
<td>Analog Inputs (Volt)</td>
<td>The LEDs indicate the detector signal (voltage level) that is currently applied to the analog input. Indication is in volt according to the logarithmic scale on the right.</td>
</tr>
<tr>
<td>6</td>
<td>Digital I/O</td>
<td>The 'Input' LED is on (green) if the related signal line is connected to digital ground. The 'Output' LED is on (red) if the related potential-free relay contact is closed.</td>
</tr>
</tbody>
</table>
## 2.4 Rear Panel

![Rear panel connectors](image)

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1   | Analog connectors (Analog Inputs)  
The UCI-100 has eight analog inputs; the UCI-50 provides analog inputs on Ch.1 and Ch. 2.  
In addition to the analog input, each analog connector provides a digital input and a digital output (→ page 8). |
| 2   | Digital Inputs connector  
The digital inputs are also distributed among the analog connectors (→ page 8). |
| 3   | LAN port (Ethernet) |
| 4   | USB port (Universal Serial Bus) |
| 5   | RS-232 ports (4 ports) |
| 6   | BCD input connector (16 BCD inputs) |
| 7   | Power socket |
2.4.1 Analog Connectors

In addition to the analog input, each analog connector (→ Fig. 2; no. 1) provides a digital input (→ section 2.4.2) and a digital output (→ section 2.4.3). For information and tips about the pin assignment, see page 49.

The UCI-100 has eight analog inputs; the UCI-50 provides analog inputs on Ch.1 and Ch. 2.

2.4.2 Digital Inputs

The digital inputs are distributed among the analog connectors (→ Fig. 2; no. 1), but are also grouped in one separate connector (→ Fig. 2; no. 2).

The digital inputs allow the time-resolved acquisition of binary events. In this way, they can be used to inform Chromeleon about external events, such as the injection of a sample. TTL signal levels are processed.

For information and tips about the pin assignment, see page 50.

2.4.3 Digital Outputs

The digital inputs are distributed among the analog connectors (→ page Fig. 2, no. 1). The relay outputs allow potential-free switching of external signals, and thus they can be used to transmit control signals to other devices. As these outputs are potential-free relay contacts, they do not depend on specific signal levels. However, the maximum capacity of the contacts has to be considered (→ Technical Information, page 45).

2.4.4 USB and LAN Ports

Data transmission between the UCI and Chromeleon is by using the integrated USB interface or LAN interface and the appropriate connection cable from the accessories kit (→ page 47). To ensure trouble-free operation, use only the cables described in section 7 (→ page 47).

For information about how to connect the UCI to the Chromeleon server OC by using a USB connection, see page 13. For information about using a LAN connection, see page 15.
2.4.5 RS-232 Ports

The four RS-232 ports allow simultaneous control of up to four modules of a chromatography timebase. For information about the pin assignment, see page 51.

_tip:_ The RS-232 ports do not support control of Gilson instruments that are equipped with an GSIOC/RS-232 adapter, model 605. Connect these instruments to the multi-serial (8-fold) PCI interface board (Equinox 8-RS2332 Multi-COM board, part no. 5906.2095) of the computer.

2.4.6 BCD Inputs

The BCD inputs of the UCI allow autosamplers that can be controlled via binary code to communicate to Chromeleon the position of the vial from which the injection was performed. The BCD inputs are 16 digital inputs that can process TTL signals.

Communication is via an appropriate flat-ribbon cable. For information and tips about the pin assignment, see page 52.

2.4.7 Power Receptacle

To connect the UCI to the main power supply, use the primary clocked power unit (‘wide range’) and an appropriate power cord. No adjustment is required to adapt the line voltage to local voltage requirements.
2.5 Operation with Chromeleon

The UCI is controlled by Chromeleon. All software details in this manual refer to Chromeleon 6.80. For information about how to set up the UCI in Chromeleon, see section 3.3.5 (→ page 27).

If you want to operate the UCI with Chromeleon 7, refer to the following documents for information about how to perform the related processes in Chromeleon 7 (all documents are included in the Chromeleon 7 shipment):

- **Chromeleon 7 Help**—provides extensive information and comprehensive reference material for all aspects of the software.

- **Quick Start Guide**—describes the main elements of the user interface and guides you step-by-step through the most important workflows.

- **Reference Card**—provides a concise overview of the most important workflows.

- **Installation Guide**—provides basic information about module installation and configuration. For specific information about a certain module, refer to the Chromeleon 7 Help.

Please also note that Chromeleon 7 terminology is different from the terminology used in Chromeleon 6.80. For details, refer to the ‘Glossary - Chromeleon 7,’ which is available in the Documents folder of your Chromeleon 7 installation.
3 Installation

3.1 Facility Requirements

- Make sure that the installation site meets the power and environmental specifications listed in the Technical Information section (→ page 45).
- Install the UCI in the laboratory on a stable and level surface that is free of vibrations.
- Make sure that the surface is resistant to solvents.
- Avoid locations with extreme changes in temperature.
- Avoid direct sunlight and drafts.
- Do not expose the UCI to any corrosive, alkaline, or water vapors.
- Allow sufficient clearance behind and to the sides of the UCI for power connections and ventilation.

3.2 Unpacking

All electrical and mechanical components of the UCI are carefully tested before the instrument is shipped from the factory. After unpacking, inspect the UCI for any signs of mechanical damage that may have occurred during transit.

Tips: Immediately report any shipping damage to both, the incoming carrier and Thermo Fisher Scientific. Shipping insurance will compensate for the damage only if reported immediately.

Keep the original shipping container and packing material. They will provide excellent protection for the UCI in case of future transit. Shipping the unit in any other packaging automatically voids the product warranty.

1. Place the shipping container on the floor and remove any accessories.
2. Grasp the module by the sides. Slowly and carefully, pull the module out of the shipping container and place it on a stable surface.

⚠️ Important: To prevent the UCI from falling, grasp the UCI by the sides, and then lift the UCI together with the foam spacers out of the shipping container. Do not lift the UCI by the foam spacers.

⚠️ Important: Afin d'empêcher l'instrument de tomber, saisissez-la par les côtés. Ne soulevez l'instrument à l'aide du matériau d'emballage ou par la porte du panneau avant.
3. Remove the foam spacers, and then remove the polythene packaging.

4. Before connecting the UCI to the power source, wait approximately four hours to allow the instrument to come to room temperature and to allow any condensation that might have occurred during shipping to evaporate. After four hours, check the UCI; if condensation still exists, allow the UCI to continue to warm up (without connecting it to the power source) until the condensation is completely gone.

### 3.3 Connecting and Setting Up the UCI in Chromeleon

#### 3.3.1 Connecting the UCI to the Chromeleon Server PC

The UCI is controlled by the Chromeleon Chromatography Management System.

Thermo Fisher Scientific recommends connecting the UCI to the Chromeleon server PC by using a USB connection (→ page 13). If a USB connection cannot be used (for example, Windows® NT 4.0 does not support USB), establish a network connection (LAN) for the communication between the UCI and the data system (→ page 15). However, in this case, observe the recommendations for network operation (→ page 26).

After connecting the UCI to the Chromeleon server PC, install and configure the UCI in Chromeleon (→ page 27).

#### 3.3.2 Connecting the UCI to External Devices

Two signal cables are included in the UCI shipment. Each cable can be used to send one analog signal and one digital signal to the UCI and also to connect one relay contact to an external device. To do so, plug the 6-pin connector of the signal cable into one of the analog inputs ports on the rear panel.

Observe the wire labels when connecting the wires to the desired components. To avoid errors in measuring, connect the ground wire to the corresponding detector connector. Additional signal cables are available on request:

<table>
<thead>
<tr>
<th>Signal cable</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mini-DIN, 6-pin, cable length: 5 m</td>
<td>6000.1004 (two cables are included in the UCI shipment)</td>
</tr>
<tr>
<td>Mini-DIN, 6-pin, cable length: 10 m</td>
<td>6911.0005</td>
</tr>
</tbody>
</table>

As a result of the cable length, the signal quality may be slightly affected when a 10 m signal cable is used.
Use the cable labeling set from in the accessories kit to label the signal cables as required. To connect devices (for example, a pump) to the RS-232 ports, use common 9-pin interface cables.

Tip: If the device to be connected is data terminal equipment (DTE), for example, a P580 pump, a null-modem cable is required.

When using the Digital Input and BCD Input connections, refer to pages 50 and 52 for information and tips about the pin assignments.

3.3.3 USB Installation

Tip: Verify that Chromeleon is installed on the computer before you connect the UCI to the USB port on the Chromeleon computer. Only then, the USB driver for the UCI is loaded automatically and the Windows® operating system can detect the UCI when the UCI is powered up.

Use the USB cable from the UCI accessories kit (→ page 47) to connect the USB port on the rear of UCI to the USB port on the Chromeleon server PC.

Keep in mind that the USB standard limits the USB cable length to 5 meters. Each USB device can be separated from the PC or next USB hub by no more than 5 meters. A special USB extension cable (part no. 6000.1005) is available if a longer connection is required. Up to five extension cables may be connected in series. However, for system reasons, the overall connection length must not exceed 30 m.

1. Turn on the computer power, if it is not already on.

2. Under Windows Vista® (Windows® XP, Windows® 7, or Windows® Server 2008), log on as a
   • Local administrator if the computer is a local computer.
   • User with local computer administrator privileges if the computer is a network computer.

3. Open the Chromeleon Server Monitor program by double-clicking the Chromeleon Server Monitor icon on the Windows taskbar.

   If the Server Monitor icon is not on the taskbar, click Start on the taskbar, point to Programs (or All Programs, depending on the operating system), point to Chromeleon, and then click Server Monitor.

4. Click Start to start the server.
5. Click **Close** to close the Server Monitor window. The Server Monitor icon appears on the taskbar.  
(Clicking the **Quit Monitor** button quits (exits) the **Server Monitor** program, but does not stop the server. To stop the server, click **Stop**.)

6. Use the power unit and power cord shipped with the UCI to connect the instrument to a grounded power source.


   will automatically detect the new UCI and perform the USB installation.

   If Windows fails to detect the UCI and launches a wizard instead, this indicates that you connected the UCI to the computer and turned on the power for the first time before you installed Chromeleon. To resolve the problem:

   a) Click Cancel to exit the wizard.

   b) Disconnect the UCI from the power source.

   c) Install Chromeleon.

   d) Reconnect the UCI to the power source. Windows will now detect the UCI and install the USB software for the UCI automatically.

   **Windows XP**

   will automatically detect the new UCI and launch the Found New Hardware Wizard, which guides you through the USB installation. Select the following options:

   a) If asked whether Windows can connect to Windows Update to search for software, select **No, not this time**.

   b) Accept the default option (**Install the software automatically**) and click **Next>**.

   c) Click **Finish** when the wizard reports that the software for the UCI has been installed.

   If Windows fails to detect the UCI and a message box asks for a USB configuration file (cmwdfusb.inf), this indicates that you connected the UCI to the computer and turned on the power for the first time before you installed Chromeleon. To resolve the problem:

   a) Click **Cancel** in the Windows message box.

   b) Disconnect the UCI from the power source.

   c) Install Chromeleon.

   d) Reconnect the UCI to the power source. Windows will now automatically detect the UCI and launch the **Found New Hardware Wizard**.

8. Set up the UCI in Chromeleon (→ page 27).
3.3.4 LAN Installation

Tip: Use the LAN connection only for Windows NT 4.0. For any other operating system, Thermo Fisher Scientific recommends using a USB connection. When using a LAN connection, observe the recommendations for network operation (→ page 26).

Use the power unit and power cord shipped with the UCI to connect the instrument to a grounded power source.

Use the LAN cable from the UCI accessories kit (→ page 47) to connect the LAN port on the rear of UCI to the LAN port on the Chromeleon server PC.

To ensure robust communication between the UCI and the Chromeleon server through a LAN connection, Thermo Fisher Scientific recommends using an instrument LAN connection between the UCI and the Chromeleon server PC as an instrument LAN is independent of the office LAN. This type of connection requires that you install a separate 10Mbit network interface card (NIC) in the Chromeleon server PC and assign unique IP addresses to all connected devices. For information about how the separate network interface card is installed in the Chromeleon server PC, refer to page 17.

If the computer already contains a second network interface card for operating other Summit HPLC devices, the UCI can be connected to this card. For information about how to connect the UCI using an instrument LAN under Windows NT4, see page 16.

After the LAN connection has been installed as described, follow the steps on page 27 an the following pages to setup the UCI in Chromeleon.

Tip: Thermo Fisher Scientific cannot guarantee reliable communication when operating the UCI on an office LAN because the load of the office LAN is a decisive factor. Overload of the office LAN may result in timeouts and loss of data and thus, disturb automatic operation of Chromeleon.

Therefore, the UCI should not be operated on an office LAN.
3.3.4.1 Connecting the UCI through an Instrument LAN (Windows NT4)

If the Chromeleon server PC is running Windows NT4, the UCI can be connected to the server PC only by using a LAN connection.

If you want to connect only a single UCI but no other instrument, you can connect the server PC and the UCI by using a 'crossover' cable, which is a special network cable with crossed-over data lines. These data lines are usually marked by colors (red, yellow) to distinguish the crossover cable from standard network cables. In this case, the structure of the instrument LAN is as follows (peer-to-peer connection):

![Peer-to-Peer connection diagram]

If you want to connect several TCP/IP-enabled Summit HPLC devices to the server PC, you must use a hub (10 Mbit) for the connection to the instrument LAN. In this case, standard network cables must be used instead of a crossover cable. One standard network cable, part no. 6906.2038, is provided in the accessories kit.)

![Hub connection (10 Mbit hub) diagram]
3.3.4.2 Separate Network Interface Card

A network connection that is independent of the office LAN is called an instrument LAN. This kind of connection between the UCI and Chromeleon requires the installation of a separate network interface card (NIC; called adapter in the operating system) in the server PC.

1. Follow the installation instructions of the card manufacturer to install the card as network interface card (Start → Settings → Control Panel → Network → Adapters → Add).

![Fig. 5: Installing the separate network interface card](image)

2. Click the **Bindings** tab and configure the network adapter for the instrument LAN (here: [2] 3Com Fast EtherLink XL NIC (3C905B-TX)). First, click the arrow next of the **Show Bindings for** box and select **all protocols** on the list to verify that the TCP/IP protocol is installed. Install the TCP/IP protocol if it is not yet installed:

![Fig. 6: Show bindings for all protocols](image)
3. Afterward, select all adapters in the Show Bindings for box. In the protocol window, disable all protocols for the instrument LAN card except the TCP/IP protocol:

![Fig. 7: Show bindings for all adapters](image)

4. As the TCP/IP protocol is used for the instrument LAN, an IP address and a subnet mask are required for the separate network adapter. The dialog box for entering the IP address and the subnet mask is opened automatically during installation. (You can reopen the dialog box later if you need to change the IP address and the subnet mask. Click Start → Settings → Control Panel → Network → Protocols. Right-click the TCP/IP protocol and click Properties on the menu.)

![Fig. 8: Assigning the IP address and subnet mask](image)
In the **Adapter** field, select the network adapter for the instrument LAN and **click Specify an IP address.**

Observe the following:
- Do not change the settings for the office LAN network interface card.
- For the adapter for the instrument LAN, disable all other network protocols and services (see further up in this section).

5. **Assign a fixed IP address to the adapter for the instrument LAN.**

First, identify the IP address that is used for the office LAN on your computer. To do so, open a DOS command prompt by clicking **Start → Programs → Command Prompt** and enter `ipconfig /all`. Differentiate between the two following cases:

**Case A:** Already used IP address ≠ 192.168.60.xxx

**Case B:** Already used IP address = 192.168.60.xxx

**Note:**
The subnet mask determines which part of the IP address describes the network and which part defines the individual devices connected to the network. Independent LANs have different network addresses. Based on the subnet mask 255.255.255.0 in the example, the term '192.168.60' describes the network, while xxx defines the individual modules in the network.

**Case A:**
Select the address from the range indicated below and enter the subnet mask specified below:

- **IP address:** 192.168.60.xxx  (xxx can be any number between 1 and 254)
- **Subnet mask:** 255.255.255.0

Do not enter a gateway address; no gateway is available for the instrument LAN and the above addresses cannot be routed. Communication between the UCI and the Chromeleon server is always direct.

Also observe the information in the Applies to both, case A and case B section on page 20.

**Case B:**
If the range 192.168.60.xxx is already used for the office LAN, use a different network range for the instrument LAN, for example, use 192.168.61.

**Important:** In this case, make sure that the addresses assigned to the individual Summit HPLC modules also start with 192.168.61. Contact your system administrator for information about the appropriate value for your individual configuration.

Do not enter a gateway address; no gateway is available for the instrument LAN and the above addresses cannot be routed. Communication between the UCI and the Chromeleon server is always direct.

Also observe the information in the Applies to both, case A and case B section on page 20.
**Applies to both, case A and case B:**

It may happen that the UCI that you want to control by the separate network adapter already has an IP address and subnet mask assigned. In this case, when selecting the IP address of the network adapter of the server PC, be sure that only the last digit differs from the IP address of the UCI. Otherwise, it will not be possible to address the connected Summit HPLC devices.

Example for a valid configuration for case A:

UCI: IP address 192.168.60.51
    Subnet mask 255.255.255.0

Server: IP address 192.168.60.50
        Subnet mask 255.255.255.0

Example for a valid configuration for case B:

UCI: IP address 192.168.61.51
    Subnet mask 255.255.255.0

Server: IP address 192.168.61.50
        Subnet mask 255.255.255.0

Observe the following:

- Every device on the same network must have a unique IP address. Selecting duplicate IP addresses may cause conflicts on the network.
- Do not use 0 or 255 as the last numbers in IP addresses.

6. To check and verify the selected settings, enter the following commands at the DOS level (Start → Programs → Command Prompt):

   **ipconfig /all**

   This command lists the configuration of all network adapters. If this command returns also the IP address and subnet mask of the newly installed 10 Mbit network adapter, the adapter has been configured successfully.

   **route print**

   This command checks whether you can address the UCI with the network adapter used for the instrument LAN. If the selected network (here, for example, 192.168.60.0) appears under **Target** and if the related subnet mask appears under **Net mask**, the new network adapter is configured correctly.

   **ping 192.168.60.51**

   This command checks the connection to the UCI that has the IP address 192.168.60.51. If the UCI will reply to the ping command, the installation is correct.

7. To operate the UCI on the instrument LAN, assign an IP address and subnet mask (→ section 3.3.4.3).

8. Set up the UCI in Chromeleon (→ page 27).
3.3.4.3 Assigning IP Properties (CmIPUtil)

To operate the UCI on an instrument LAN, an IP address, and subnet mask must be assigned, by using the CM IP Utility program.

Observe the following:

- Parameters can be programmed and changed only if no data is being transferred between the UCI and the Chromeleon server. To stop the Chromeleon server, click Start → Programs → Chromeleon → Server Monitor.

- Configuration is possible only if the computer on which CmIPUtil is running is connected to the same subnet as is the UCI for which you want to assign IP properties.

- With CM IP Utility, only UCI modules with firmware version 2.0 or later (LAN support) can be configured.

  **Tip:** If you want to use the network capabilities of a UCI with a firmware version < 2.0, first download the most recent firmware to the module (→ page 43). This is possible only by using the USB connection. Afterward, configure the module as described further down in this section.

- Make sure that the TCP/IP protocol is available on the computer.

1. Copy the CmIPUtil program from the Chromeleon CD into a separate directory on your computer if it is not yet already there.

2. Double-click Setup.exe and follow the installation instructions on the screen.

3. Open the program by clicking Start → Programs → Chromeleon → IP Utility → CmIPUtil.

   The Module Information window of the dialog box lists all modules that are active on the network, together with their IP address, serial number (S/N), server name (that is the name or IP address of that server with which data are currently exchanged), gateway address, subnet mask, and Ethernet address. The IP address for modules that have not yet been configured is 0.0.0.0 or 255.255.255.255 (→ Fig. 9, page 22).
4. Enter the IP address and the subnet mask for the modules to be configured. The values depend on the settings for the adapter for the instrument LAN (→ page 20).

5. Select the module to be configured by the serial number.

6. In the **Available IP Addresses** window, select the IP address to be assigned to the UCI. If it is not listed, click **Add/Remove** and enter the desired address.

7. Enter the required subnet mask. Verify that this is the same subnet mask is used for the Chromeleon server PC.

   In this case, when selecting the IP address of the network adapter of the server PC, be sure that only the last digit differs from the IP address of the UCI. Otherwise, it will not be possible to address the connected Summit HPLC devices.

Example for a valid configuration:

   **UCI:**
   
   - IP address: 192.168.60.51
   - Subnet mask: 255.255.255.0

   **Server:**
   
   - IP address: 192.168.60.50
   - Subnet mask: 255.255.255.0

To configure several TCP/IP-enabled Summit HPLC devices, make sure that every device has its own IP address. For the example, the following entries would be possible:

2. **TCP/IP enabled device:**
   
   - IP address: 192.168.60.52
   - Subnet mask: 255.255.255.0

3. **TCP/IP enabled device:**
   
   - IP address: 192.168.60.53
   - Subnet mask: 255.255.255.0
Observe the following:

- Every device on the same network must have a unique IP address. Selecting duplicate IP addresses may cause conflicts on the network.
- Do not use 0 or 255 as the last numbers in IP addresses.

8. The **Gateway Address** input box must not be empty, although no gateway is available for the instrument LAN. Therefore, enter the IP address of the device to be configured also in this input box to prevent a gateway from being used.

9. When the necessary entries are complete, click **Assign** to assign to the module. After about one second, the module will appear with new parameters in the Module Information window.

10. Click **Query** to check the settings.

11. Click **Exit** to close the program.

**Tip:** Verify that a unique IP address has been assigned to all Summit HPLC devices that are connected to the Chromeleon server PC.

For more information, see the *CmIPUTil Help*. 
3.3.4.4 Network Operation

3.3.4.4.1 Network Traffic
The TCP/IP protocol, which is known from the Internet, is used for the LAN communication between the UCI and Chromeleon. The network traffic, which depends on the amount of raw data to be transported (number of active analog channels), is as follows:

**LAN traffic (RS232 Ports not active)**

![Fig. 10: LAN traffic without active RS-232 ports](image1)

**LAN traffic (all RS232 Ports active)**

![Fig. 11: LAN traffic with active RS-232 ports](image2)
3.3.4.4.2 Puffer Time
Operating the UCI by using a LAN connection in case of high network traffic may lead to transmission failures. That is why the raw data are temporarily stored in the UCI module. However, the available memory capacity depends on the amount of raw data to be transported (→ Fig. 12) and thus, is limited.

![Graph showing the maximum buffer time in case of network overload.](image)

*Fig. 12: Max. buffer time in case of network overload*

**Tip:** If the network failure exceeds the buffer time described above, analog data may be lost.

If you notice these effects, Thermo Fisher Scientific recommends establishing a USB connection between the UCI and the Chromeleon server. As the USB bus is capable of performing real-time operations, overloading effects will not occur. If a USB connection cannot be established, take appropriate measures to avoid interruptions of the network communication between the Chromeleon server and the UCI (→ Recommendations for Network Operation, page 26).
3.3.4.4.3 Recommendations for Network Operation

Unlike USB connections, Ethernet LAN connections have limited real-time capabilities. Data transmission can occur only when no other connected user is using the network. To take full advantage of the real-time capabilities of the UCI, select the instrument LAN connection (→ page 16). This ensures that other network users do not delay the server communication.

If the UCI module is connected to Chromeleon by a LAN connection, Thermo Fisher Scientific advises against using the digital inputs for remote inject synchronization. This is because the timing of LAN communication varies, depending on the current LAN traffic.

If the UCI module is connected to Chromeleon by using a USB connection, all remote inputs are polled after 0.1 seconds and can be used without restrictions.

Tip: Thermo Fisher Scientific cannot guarantee reliable communication when operating the UCI on an office LAN because the load of the office LAN is a decisive factor. Overload of the office LAN may result in timeouts and loss of data and thus, disturb automatic operation of Chromeleon. Therefore, the UCI should not be operated on an office LAN.
3.3.5 Setting Up the UCI in Chromeleon

All software details in this manual refer to Chromeleon 6.80. If you want to operate the UCI with Chromeleon 7, note the information on page 10.

3.3.5.1 Installing the UCI

After the USB software for the NCS has been installed (→ page 13) or the LAN connection has been established (→ page 15), install and configure the UCI in Chromeleon:

1. Start the Chromeleon Server Monitor and the Chromeleon server if they are not yet running.
   a) Open the Chromeleon Server Monitor program by double-clicking the Chromeleon Server Monitor icon 🗝️ on the Windows taskbar. (If the Server Monitor icon is not on the taskbar, click Start on the taskbar, point to Programs (or All Programs, depending on the operating system), point to Chromeleon, and then click Server Monitor.)
   b) Click Start to start the server.
   c) Click Close to close the Server Monitor window. The Server Monitor icon 🗝️ appears on the taskbar. (Clicking the Quit Monitor button quits (exits) the Server Monitor program, but does not stop the server. To stop the server, click Stop.)

2. Start the Chromeleon Server Configuration program by clicking Start on the taskbar. Point to Programs (or All Programs, depending on the operating system), point to Chromeleon, and then click Server Configuration.

3. Click the plus sign next to the server name to display the items underneath.

4. Right-click Sharable Devices in the timebase and click Add Sharable Device on the menu.

5. In the list box, select Dionex UCI-1000 Interface (or UCI-50 Interface) and click OK to confirm the selection.

6. The configuration pages for the UCI are opened. On each page, verify that the settings are correct and select additional settings if needed. For a description of the pages, see section 3.3.5.2 (→ page 28).

7. On the File menu, click Save Installation and then close the Server Configuration program.
3.3.5.2 Configuring the UCI

Verify that the default settings are correct and change them if needed. If you want to change the settings at a later date, double-click the UCI to reopen the configuration pages.

Tip: Changing the settings for a specific application in the Commands dialog box, in a program file (PGM), or on a control panel will not change the default settings on the configuration pages.

For additional information about a page, click Help.

General page

The General page shows the general instrument parameters.

Fig. 13: General page

- **Demo Mode**
  Select the Demo Mode check box if you want to read and display a demo chromatogram instead of real data. To specify the demo chromatogram, select the Demo tab (→ page 30).

- **Firmware Download**
  Click this button to transfer the firmware version available for the UCI in Chromeleon to the module. (The button appears dimmed if the Demo Mode is enabled.)

  The UCI is shipped with the most recent firmware version. If a firmware update is ever required, follow the steps in section 5.2 (→ page 43).
• **Module Address**
   Click **Browse** to select the module address of the UCI. (The button appears dimmed if the Demo Mode is enabled.)

   ![Device list](image)

   **Fig. 14: Device list**

   The following information is displayed:
   - The **Address** column lists all UCI modules that are available via Ethernet (TCP/IP) together with their IP address and/or all UCI modules that are available via USB with the prefix 'USB' and their serial number.
   - The **Server Name** column indicates whether a UCI is already connected to a Chromeleon server PC. If a UCI is available for connection to the server, the entry is 0.0.0.0 or the column is empty.
   - The **S/N** column shows the serial number of the UCI.
   - The **Ethernet** column shows the Ethernet address of the UCI.

   Double-click the UCI that you want to use. The address is automatically entered in the Module Address box. Clicking OK establishes the connection to the module. This process may take some seconds. As soon as the connection has been established successfully, the related **Connect** message including the firmware version is displayed in the audit trail.

   **Tip:** A UCI module can be connected to only one chromatography server. However, its interfaces and signals can be shared among several timebases (Shared Device; → page 33).

• **LAN Timeout**
   You can specify a **LAN Timeout** between 1 and 30 seconds. For LAN connections with high network traffic, this setting allows prolonging the timeout for the communication between the Chromeleon server and devices that are connected to the RS-232 port of the UCI.
Demo Page

On the Demo tab, specify the demo chromatogram.

![Demo page](Image)

If the Demo Mode check box is selected on the General tab page, the UCI does not use previously recorded signal course, but simulates data acquisition and reads out and displays a demo chromatogram instead of real data. For this purpose, the UCI driver includes a 'Software Peak Generator'. Use this page to specify the signal properties for the demo chromatogram.

No entries are required on this page if you want to use the default chromatogram. Otherwise, select the 12 peaks in succession and specify the following:

- In the Retention Time box, enter the preferred retention time in minutes.
- In the Left Width@5% box, enter the left peak width at 5% of the peak height.
- In the Right Width@5% box, enter the right peak width at 5% of the peak height.
- In the Height box, enter the peak height.

The demo chromatogram can include up to 12 peaks. To exclude a peak from the chromatogram, set the peak height to zero. To create overlapping peaks, use the left and right peak width settings.

To determine the signal noise for the demo chromatogram, enter the preferred value in the Noise box.

For more information, see the Chromeleon Help.
3.3.5.3 Adding more than one UCI to the Server Configuration

If the server configuration already includes one UCI and you want to add another UCI module, a message appears indicating that the UCI driver has already been installed:

![Figure 16: Message that a UCI driver is already loaded](image)

Click Yes to load another instance. Continue the installation as described in section 3.3.5.1 (→ page 27).

When the installation is complete, the UCI appears in the Server Configuration program together with the related instance number. One Chromeleon server can control up to four UCI modules:

![Figure 17: Server configuration including several UCI modules](image)

For more information, see the Chromeleon Help.
3.3.5.4 Setting Up the Analog Inputs

If you want to use the analog inputs of the UCI in Chromeleon, the timebase must include either the Integrator Driver or the device driver for a third-party analog detector. The steps below refer to the installation of the Integrator Driver; however, they are similar for other third-party device drivers:

1. In the Server Configuration program, select the timebase to which you want to add the Integrator Driver or create a new timebase (on the Edit menu, click Add Timebase).

2. Open the Add device to timebase dialog box. To do so, click Add Device on the Edit menu or right-click the timebase and click Add Device on the menu.

3. On the Manufacturers list, click Generic and on the Devices list, click Integrator Driver.

4. On the Signals page, select the signals that you want to use by the check box. If a check box is cleared, the signal will not be available in Chromeleon.

5. To configure the signals to be used, select a signal and click Change.

6. The Signal Configuration dialog box provides the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Name</td>
<td>Enter a unique signal name for future identification of the signal. Avoid changing previously assigned names. Changing names may result in conflicts with existing PGM Files and panel controls. Any raw data recorded for the related signal are directly linked to the signal name.</td>
</tr>
<tr>
<td>AD Port</td>
<td>Select the channel to be used for signal recording with the UCI. Make sure that the selected channel corresponds to the actual pin assignment. If more than one UCI module is installed in the Server Configuration program, keep in mind that the AD ports of the different modules can be distinguished only by the instance numbers of the UCI.</td>
</tr>
<tr>
<td>Unit</td>
<td>Enter the signal unit (for example, mV or mAU).</td>
</tr>
<tr>
<td>Factor</td>
<td>The Factor is the conversion factor between mV and the signal unit of the connected detector. If the signal value at the detector output is, for example, 1000 mV, and if the signal shall be represented in mAU instead, enter mAU in the Unit box and 1 in the Factor box.</td>
</tr>
<tr>
<td>Offset [mV]</td>
<td>Each A/D-channel can receive a signal offset that is added to the actual signal. This can be used to balance pressure or temperature readings. For example, if a thermometer supplies a voltage of 1 V at 0 °C, this can be compensated by entering an offset value of -1000 mV.</td>
</tr>
</tbody>
</table>

7. Confirm the entries by clicking Ok. The Integrator Driver is installed and the selected signals are available in Chromeleon.

For more information, see the Chromeleon Help.
### 3.3.5.5 Setting Up the Digital Inputs, BCD Inputs, and Relay Outputs

The available relays and digital inputs are **Shared Devices**, that is, they need not be used on the same timebase. If you want to use the relays and digital inputs of the UCI in Chromeleon, installation of **Shared Relays and Inputs** driver is required.

1. In the **Server Configuration** program, select the timebase to which you want to add the Shared Relays and Inputs driver or create a new timebase (on the Edit menu, click Add Timebase).

2. Open the **Add device to timebase** dialog box. To do so, click Add Device on the Edit menu or right-click the timebase and click Add Device on the menu.

3. On the **Manufacturers** list, click **Generic** and on the **Devices** list, click **Shared Relays and Inputs**. The configuration pages for the driver are opened.

4. **Relays / TTL Outputs** page
   - Click **Add** and then, in the **Port Assignment** dialog box, assign the preferred ports to the relays and TTL outputs.
   - In the **Name** box, enter a unique name for future identification of the signal. In the **Port** box, select the UCI port that you want to use from the drop-down list (UCI100_Relay1 through UCI100_Relay8). The relay numbers on the list correspond to the channel numbers (Ch. 1 to Ch. 8) on the rear panel of the UCI.

5. **TTL Inputs** page
   - Click **Add** and then, in the **Port Assignment** dialog box, assign the preferred ports to TTL inputs.
   - In the **Name** box, enter a unique name for future identification of the TTL input. In the **Port** box, select the UCI port that you want to use on the drop-down list (UCI100_Input1 through UCI100_Input8, UCI100_BCD-1A, UCI100_BCD-1B). The input numbers on the list correspond to the ports according to the tables on pages 50 and 52.

6. Confirm the entries by clicking **Ok**. The **Shared Relays and Inputs** driver is installed and the selected signals are available in Chromeleon.

**Tips:** If more than one UCI module is installed in the Server Configuration program, keep in mind that the relays and TTL inputs of the different modules can be distinguished only by the instance numbers of the UCI.

With controlled chromatographic systems, the autosampler communicates the time of injection to Chromeleon via an RS-232 cable. This is not possible for non-controlled injection units. In this case, the **Remote Inject** driver is required to communicate the time of injection from the autosampler or a manual injection unit to Chromeleon and thus, to synchronize the start of data acquisition with the injection.
7. Install the **Remote Inject** driver if it is not yet installed. In the Chromeleon **Server Configuration** program, right-click the timebase in which you want to install the driver and select **Add Device** on the menu.

8. On the **Manufacturers** list, click **Generic** and on the **Devices** list, click **Remote Inject**. The configuration pages for the driver are opened.

9. **General** page

   **Device Name** displays the name used to identify the external injection unit in the installation environment. To use existing control panels, accept the default name. If you enter a different name, you may have to re-link the controls on the control panels and edit the name in the program files.

   The **Inject Port** list shows all external remote start devices that have not yet been selected as inject port. Select the inject port (= preferred UCI port) that sends the signal. When executing a program, Chromeleon executes the Inject command and continues with the program only after the signal from the inject port has been received.

10. Confirm the entries by clicking **Ok**. The **Remote Inject** driver is installed and available in Chromeleon.
3.3.5.6 **Assigning the RS232-Ports**

To control a device via an RS-232 port of the UCI, the related communication port must be assigned in the configuration of the device that you want to control.

1. In the **Server Configuration** program, right-click the device and click **Add Properties** on the menu.

2. On the **General** page, select the preferred port on the **Port** list. The port numbers on the list correspond to the port numbering on the rear panel of the UCI.

   **Tips:** Thermo Fisher Scientific recommends using the USB connection to control devices via the RS-232 ports (→ Puffer Time, page 25).

   If more than one UCI module is installed in the Server Configuration program, keep in mind that the RS-232 ports of the different modules can be distinguished only by the instance numbers of the UCI.

3.3.5.7 **Commands and Properties in Chromeleon**

After the installation, the components appear together with their commands and properties in Chromeleon, in the **Commands** dialog box. They are listed under the name specified during the installation. To open the **Commands** dialog box, click **Command** on the **Control** menu. (The Control menu is visible only when a control panel is open.)

The commands and properties that are available in the dialog box may vary, depending on the Chromeleon version, configuration, and the display filter level (Normal, Advanced, or Expert). Change the display filter level if necessary. For more information, see the Chromeleon Help.

The following commands/properties are available for the analog inputs:

<table>
<thead>
<tr>
<th>Command/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delta</td>
<td>The signal slope, useful for triggers (difference between the current value and the value one second ago)</td>
</tr>
<tr>
<td>Retention</td>
<td>The retention time of the signal (range 0.00 to 10000000.00 min)</td>
</tr>
<tr>
<td>Signal</td>
<td>The current signal value (range -10000.00 to 10000.00 mV). Click the + sign next to Signal to display the items underneath: Value (current value), UpperLimit, and LowerLimit. The system aborts the sample batch if the value is outside the upper and lower limits.</td>
</tr>
<tr>
<td>AcqOff</td>
<td>Stops data acquisition.</td>
</tr>
<tr>
<td>AcqOn</td>
<td>Starts data acquisition.</td>
</tr>
<tr>
<td>MaxAutoStep</td>
<td>Maximum step rate for Auto Step mode (default: 5.1 seconds).</td>
</tr>
</tbody>
</table>
The following commands/properties are available for the relays:

<table>
<thead>
<tr>
<th>Command/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Indicates (or sets) the state of the relay. Available options: <strong>On</strong> and <strong>Off</strong>.</td>
</tr>
<tr>
<td>Duration</td>
<td>If set, the relay will toggle after the specified time (range: 0.00 to 59999.90 sec.)</td>
</tr>
<tr>
<td>On</td>
<td>Opens the relay.</td>
</tr>
<tr>
<td>Off</td>
<td>Closes the relay.</td>
</tr>
</tbody>
</table>

The following commands/properties are available for the TTL inputs:

<table>
<thead>
<tr>
<th>Command/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Indicates (or sets) the state of the relay. Available options: <strong>On</strong> and <strong>Off</strong>.</td>
</tr>
</tbody>
</table>

For more information, see the *Chromeleon Help*. 
4 Troubleshooting

Messages that appear in the Chromeleon Audit Trail (see table further down in this section) help you to identify and eliminate the source problems that may occur during the operation of the UCI. Observe the following:

- Error messages will vary slightly, depending on the connection type specified for the UCI in the Server Configuration program (USB or LAN). Thus, the error messages below may also read UCI-100 @ USB-00-E0-EF-DE-XX-XX (for XX-XX see the rear panel of the UCI), UCI-100 @ + IP address (for example, UCI-100 @ 192.168.50.1) or UCI-100@ + serial number (for example, UCI-100@USB-01610103) instead of just UCI-100. This applies in the same way to the UCI-50.

- If the server configuration has been changed in any way, messages referring to the previous configuration may continue to appear for up to 30 seconds after the change. These messages can be ignored. Therefore, always note the device name (UCI-100 @... or UCI-50@...) referenced in the message.

- Before loading down the firmware, disconnect the Chromeleon server from any instruments that are controlled via the RS-232 ports of the UCI. The connection must be interrupted during the firmware download. Terminating the connection during the download may result in various error messages in the Audit Trail.

If you are unable to eliminate a problem following the instructions given here, contact Thermo Fisher Scientific Service for Dionex HPLC Products.

The following table lists the most important messages along with possible causes and suggests remedial actions.

<table>
<thead>
<tr>
<th>Message</th>
<th>Probable Cause</th>
<th>Remedial action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No response from UCI for 5 seconds. The network may be</td>
<td>The network load is too high.</td>
<td>Reduce the network load. The network connection between the Chromeleon server and the UCI might be inappropriate (→ page 26). Contact your network administrator.</td>
</tr>
<tr>
<td>broken or overloaded.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No response from UCI for 30 seconds. Device disconnected.</td>
<td>The connection between the UCI and the Chromeleon server PC may be interrupted. The power supply to the UCI may be interrupted.</td>
<td>Check the network connection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check the connection to the power supply of the UCI.</td>
</tr>
<tr>
<td>Message</td>
<td>Probable Cause</td>
<td>Remedial action</td>
</tr>
<tr>
<td>---------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>No response from UCI for 30 seconds. Device disconnected. <em>(Cont'd)</em></td>
<td>The network load is too high.</td>
<td>Reduce the network load. The network connection between the Chromeleon server PC and the UCI might be inappropriate (<em>→</em> page 26). Contact your network administrator.</td>
</tr>
<tr>
<td>No response from UCI-100 @ USB-00-E0-EF-DE-XX-XX for 5 seconds. The network may be broken or overloaded.</td>
<td>The type of connection between the UCI and the Chromeleon server PC was changed from a LAN connection to a USB connection.</td>
<td>This message can be ignored.</td>
</tr>
<tr>
<td>Error opening UCI - Connection refused.</td>
<td>The UCI is connected to another Chromeleon server PC.</td>
<td>Verify that the correct UCI is selected. Terminate the communication between the UCI and the other Chromeleon server PC.</td>
</tr>
<tr>
<td></td>
<td>The existing connection is not yet cleared completely.</td>
<td>Wait for 30 seconds and repeat the procedure.</td>
</tr>
<tr>
<td></td>
<td>The subnet mask and gateway address of the UCI are configured incorrectly.</td>
<td>Check and change the parameter settings in CmiIPUtil if necessary (<em>→</em> page 21).</td>
</tr>
<tr>
<td></td>
<td>A gateway may maintain an unintended connection to a UCI when the Chromeleon server PC is stopped in a non-controlled way (for example, due to a power-failure).</td>
<td>Restart the UCI.</td>
</tr>
<tr>
<td>Error opening UCI - Connection timed out.</td>
<td>The Chromeleon server PC failed to connect to the UCI.</td>
<td>Verify that the UCI is powered-up and that the network connection is working. Note the name of the UCI to which the message refers. The error message might refer to a UCI that is no longer part of the current server configuration. But the Chromeleon server PC still tries to connect to this module. Check and change the module address as necessary and retry.</td>
</tr>
<tr>
<td></td>
<td>The network connection was interrupted during firmware download.</td>
<td>Check the network connection.</td>
</tr>
<tr>
<td>Message</td>
<td>Probable Cause</td>
<td>Remedial action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Error opening UCI - Connection timed out. (Cont’d)</td>
<td>The power supply to the UCI was interrupted during firmware download.</td>
<td>Check the connection to the power supply of the UCI. Restart the UCI and repeat the firmware download. If the message appears again, contact Service.</td>
</tr>
<tr>
<td>UCI - Connection reset by peer.</td>
<td>The network load is too high. The power supply to the UCI has been interrupted for a short period.</td>
<td>Reduce the network load (→ page 26). Check the connection to the power supply of the UCI.</td>
</tr>
<tr>
<td>UCI - Host not found.</td>
<td>Network problems: The connection to the UCI cannot be established.</td>
<td>Check network settings for the UCI and network interface card. The network connection between the Chromeleon server PC and the UCI might be inappropriate (→ page 26). Contact your network administrator.</td>
</tr>
<tr>
<td>UCI - Permission denied.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UCI - Network is unreachable.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UCI - No route to host.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UCI - Lost XXX data packets.</td>
<td>The network load is too high. The connection between the UCI and the Chromeleon server is interrupted for a longer period.</td>
<td>Reduce the network load (→ page 26). Check the network connection.</td>
</tr>
<tr>
<td>The device couldn't be queried for its firmware version. The new version is x.xx Download anyway?</td>
<td>When the firmware download is started, there is no connection between the Chromeleon server and the UCI specified in the Server Configuration program under Sharable Device &gt; Properties &gt; Module Address. Thus, the firmware version that is installed in the UCI cannot be established.</td>
<td>If you want to download the firmware without checking the current firmware version of the UCI, confirm the message. As soon as the connection to the UCI specified in the Server Configuration program has been established, the firmware is download, replacing the firmware version installed in the UCI by the version indicated in the message. If you want to check the current firmware version before the download, make sure that the connection to the UCI is established before the download is started (→ page 43).</td>
</tr>
<tr>
<td>UCI. The amplifiers are not working in the specified gain range.</td>
<td>The electronics of the specified UCI works near the limits specified for operation.</td>
<td>You may continue working. However, you should contact Service.</td>
</tr>
<tr>
<td>The deviation can still be compensated but maintenance is recommended.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UCI. The amplifiers are not working in the specified gain range.</td>
<td>The electronics of the specified UCI does not work within the limits specified for operation.</td>
<td>Contact Service.</td>
</tr>
<tr>
<td>Message</td>
<td>Probable Cause</td>
<td>Remedial action</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>UCI - Error erasing flash memory.</td>
<td>The connection between the UCI and the Chromeleon server PC is interrupted during the firmware download.</td>
<td>Check the USB or LAN connection and also the connection to the power supply of the UCI. Restart the UCI and repeat the firmware download. If the message appears again, contact Service.</td>
</tr>
<tr>
<td>—or—</td>
<td>The power supply to the UCI may be interrupted.</td>
<td></td>
</tr>
<tr>
<td>UCI - Error programming flash memory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>—or—</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UCI - Error finishing download.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UCI - Firmware download failed.</td>
<td>The firmware download failed several times. The message appears together with other messages describing the cause (for example, UCI - Error erasing flash memory, - Error programming flash memory, - Error finishing download).</td>
<td>Perform the remedial actions for the messages that appear in the Audit Trail before this message.</td>
</tr>
<tr>
<td>UCI-100 @ USB-00-E0-EF-DE-XX-XX - Device not found on the USB.</td>
<td>The USB connection between the UCI and the Chromeleon server may be interrupted.</td>
<td>Check the USB connection.</td>
</tr>
<tr>
<td></td>
<td>The power supply to the UCI may be interrupted.</td>
<td>Check the connection to the power supply of the UCI.</td>
</tr>
<tr>
<td>Error opening UCI-100 @ USB-00-E0-EF-DE-XX-XX – The System cannot find the file specified.</td>
<td>The USB connection between the UCI and the Chromeleon server may be interrupted.</td>
<td>Check the USB connection.</td>
</tr>
<tr>
<td></td>
<td>The power supply to the UCI may be interrupted.</td>
<td>Check the connection to the power supply of the UCI.</td>
</tr>
<tr>
<td>Error issuing control request to UCI-100 @ USB-00-E0-EF-DE-XX-XX – The selected configuration does not exist. A firmware download may be necessary.</td>
<td>The firmware download has not completed correctly due to termination of the USB connection.</td>
<td>Check the USB connection. Start or repeat the firmware download. Check the connection to the power supply of the UCI.</td>
</tr>
<tr>
<td>Error issuing control request to UCI</td>
<td>The Chromeleon server cannot connect to the UCI indicated in the message.</td>
<td>Check the USB or LAN connection and also the connection to the power supply of the UCI. Remove the UCI indicated in the message from the configuration. Else, select a different UCI on the list of available UCI modules in the Server Configuration program.</td>
</tr>
<tr>
<td>Message</td>
<td>Probable Cause</td>
<td>Remedial action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Error reading from UCI-100 @ USB-00-E0-EF-DE-XX-XX Data error (cyclic redundancy check)</td>
<td>Communication error between the UCI and the Chromeleon server PC.</td>
<td>Check the USB connection. The connection to the next hub must not exceed 5 m. The overall connection length, including the hub connections must not exceed 30 m. Replace any defective USB cable or hub.</td>
</tr>
<tr>
<td>Error reading from UCI-100 @ USB-00-E0-EF-DE-XX-XX</td>
<td>The connection between the UCI and the Chromeleon server may be interrupted. The power supply to the UCI may be interrupted.</td>
<td>Check the USB connection. Check the connection to the power supply of the UCI.</td>
</tr>
</tbody>
</table>
5 Maintenance and Service

5.1 General Information

No maintenance is required on part of the user. Service procedures must be performed by Thermo Fisher Scientific service personnel.

Before returning any UCI for repair, contact Thermo Fisher Scientific Service for Dionex HPLC Products. An RMA (Return Material Authorization) number is required to track your instrument. Always use the original shipping container. Shipping the instrument in anything else than the original packaging voids the warranty. For more information, see the warranty statement in the terms of sale.

5.2 Updating the UCI Firmware

The UCI is shipped with the most recent firmware version. The UCI firmware is also included in Chromleon. To check which firmware version is included in Chromleon, locate the IQReport.log file in the IQ folder of your Chromleon installation and, in the file, search for UCI100.hex (or UCI50.hex).

Whenever a new firmware version is released for the UCI, the new version will be provided with the next Chromleon Service Release and described in the related release notes.

The new firmware will not be downloaded automatically to the UCI when you install a Chromleon Service Release.

Observe the following:

- Before loading down the firmware, disconnect the Chromleon server from any instruments that are controlled via the RS-232 ports of the UCI. The connection must be interrupted during the firmware download. Terminating the connection during the download may result in various error messages in the Audit Trail (→ page 37).

- To ensure that the download is successful, make sure that the communication between the UCI and Chromleon is not interrupted during the download and that you do not disconnect the UCI from the power supply.

- If the UCI has a firmware version < 2.0 installed, the download is possible only by using the USB connection. To use the LAN capabilities of the UCI after the download, configure the module for network operation in CmlIPUtil (→ page 21).
To update the firmware in the UCI, follow these steps:

1. Verify that the Chromeleon server is in running idle mode, that is, all processes on the Chromeleon server PC and in Chromeleon have been stopped.

2. Start the **Server Configuration** program (→ page 27).

3. Right-click the UCI in the timebase and click **Properties** on the menu.

4. On the **General** page, click Firmware Download (→ page 28). A message displays the firmware version that is currently installed in the UCI and the version that will be downloaded from Chromeleon.

   **Tip:** If the UCI comes with a newer firmware than the version included in Chromeleon, do not downgrade the firmware. Older firmware may be incompatible with new hardware revisions.

5. Click **Yes** to start the download. (Click No to cancel the action.)

The download may take several minutes. The download is complete when **Download completed successfully** appears in the **Messages Server** window in the Chromeleon Server Configuration program. The message appears also in the Chromeleon Audit Trail.

If the download is not successful, the related messages appear in the Audit Trail. In this case, turn the UCI off and on again. Repeat the download as described above. If the download fails again, contact Thermo Fisher Scientific Service for Dionex HPLC Products.
## 6 Technical Information

### Analog Inputs:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number UCI-100</td>
<td>8 (independent); UCI-50: 2 (independent)</td>
</tr>
<tr>
<td>Max. input voltage</td>
<td>± 0 Volt (bipolar)</td>
</tr>
<tr>
<td>Input impedance (analog)</td>
<td>$&gt; 10^7 \Omega$ (static)</td>
</tr>
<tr>
<td>Dynamic resolution</td>
<td>25 bit</td>
</tr>
<tr>
<td>Number of input ranges</td>
<td>8 (with autoranging)</td>
</tr>
<tr>
<td>Resolution</td>
<td>$&lt; \pm 1 \mu V$</td>
</tr>
<tr>
<td>Voltage noise</td>
<td>$&lt; 2 \mu V$, peak to peak</td>
</tr>
<tr>
<td>Offset (absolute)</td>
<td>$&lt; \pm 10 \mu V$</td>
</tr>
<tr>
<td>Voltage drift</td>
<td>$\leq 20$ ppm/$^\circ$C (on each range)</td>
</tr>
<tr>
<td>Sampling rate</td>
<td>100 Hz per channel</td>
</tr>
<tr>
<td>Linearity (0-5000 mV)</td>
<td>Correlation coefficient $&gt; 99.9999%$, RSD $&lt; 0.15%$</td>
</tr>
</tbody>
</table>

### Digital Inputs:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>8 (TTL compatible)</td>
</tr>
<tr>
<td>Input voltage (digital)</td>
<td>0–5 Volts</td>
</tr>
</tbody>
</table>

### Relay outputs:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>8</td>
</tr>
<tr>
<td>Functionality</td>
<td>Default open</td>
</tr>
<tr>
<td>Switching capacity</td>
<td>100V, 0.5A, 10W max.; potential free</td>
</tr>
</tbody>
</table>

### RS-232 ports:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>4</td>
</tr>
<tr>
<td>Baud rate</td>
<td>Up to 9600 baud (all channels)</td>
</tr>
<tr>
<td></td>
<td>Up to 19200 baud (two channels)</td>
</tr>
<tr>
<td></td>
<td>Up to 38400 baud (one channels)</td>
</tr>
<tr>
<td>Handshake</td>
<td>RTS/CTS hardware or Xon/Xoff software</td>
</tr>
</tbody>
</table>

### PC interfaces:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>USB version 1.1; Ethernet LAN: 10BASET (RJ45 connector)</td>
</tr>
</tbody>
</table>

### Miscellaneous:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environmental conditions</td>
<td>Range of use: Indoor use</td>
</tr>
<tr>
<td></td>
<td>Temperature: 10 °C to 35 °C (50 to 95 °C)</td>
</tr>
<tr>
<td></td>
<td>Air humidity: 40 to 85% relative humidity, non-condensing</td>
</tr>
<tr>
<td></td>
<td>Overvoltage category: II</td>
</tr>
<tr>
<td></td>
<td>Pollution degree: 2</td>
</tr>
<tr>
<td>Weight</td>
<td>1.95 kg</td>
</tr>
<tr>
<td>Dimensions (H x W x D)</td>
<td>71 x 285 x 220 mm</td>
</tr>
</tbody>
</table>

*Technical information: November 2010. All technical specifications are subject to change without notice.*
### 7 Accessories and Spare Parts

Accessories, consumables, and spare parts are always maintained at the latest technical standard. Therefore, part numbers are subject to alteration. However, updated parts will always be compatible with the parts they replace.

#### 7.1 Standard Accessories

The following accessories are shipped with the instrument (the list is subject to change without notice). The part number always refers to the packing unit. Unless otherwise stated, the packing unit is 1 unit. For more information, contact the Thermo Fisher Scientific sales organization for Dionex HPLC Products.

<table>
<thead>
<tr>
<th>Description</th>
<th>Quantity in the kit</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal cable (6-pin Mini-DIN, 5 m)</td>
<td>2</td>
<td>6000.1004</td>
</tr>
<tr>
<td>USB cable, 5 m, type A to type B</td>
<td>1</td>
<td>6911.0002</td>
</tr>
<tr>
<td>RS54 cable for Ethernet connection, 3 m</td>
<td>1</td>
<td>69062038</td>
</tr>
<tr>
<td>Power supply unit 12 V DC, 1.25A ('wide range')</td>
<td>1</td>
<td>1510.0003</td>
</tr>
<tr>
<td>Cable labeling set, 1-8 Dmax 4.7</td>
<td>1</td>
<td>5911.9011</td>
</tr>
</tbody>
</table>

#### 7.2 Optional Accessories

<table>
<thead>
<tr>
<th>Description</th>
<th>Part No.</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB extension cable with signal amplifier (5 m)</td>
<td>6000.1005</td>
<td>Up to five extension cables may be connected in series. However, for system reasons, the overall connection length must not exceed 30 m.</td>
</tr>
<tr>
<td>Signal cable, UCI (10 m)</td>
<td>6911.0005</td>
<td>As a result of the cable length, the signal quality may be slightly affected when the 10 m signal cable is used.</td>
</tr>
</tbody>
</table>
8 Pin Assignment

8.1 General Information

The following sections provide detailed information about the pin assignment of the analog, digital, and BCD inputs as well as about the DC input and RS-232 ports. The USB and LAN interfaces correspond to the respective standards.

⚠️ Important: To prevent damage to the UCI, observe the polarity (digital inputs) and be sure that the input voltages not within the valid range.

⚠️ Important: L'inversion de polarité (entrées numériques) et des tensions d'entrée en dehors du domaine de validité put endommager l'instrument.

8.2 Analog Inputs

Fig. 18: Analog input (6-pin connector, rear panel view)

<table>
<thead>
<tr>
<th>Pin Assignment</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog LOW ↔ Analog HIGH</td>
<td>± 10 V</td>
</tr>
<tr>
<td></td>
<td>(The UCI-50 provides analog inputs on Ch. 1 and Ch. 2.)</td>
</tr>
<tr>
<td>Digital Input ↔ Digital GND</td>
<td>0 or ±5 V</td>
</tr>
<tr>
<td>Digital Out (GND) ↔ Digital Output</td>
<td>Switching: 100 V; switching current: 0.5 A limiting value of mean on-state current: 1.0 A; switching capacity: 10 W/10 VA volume resistance: max. 0.15 Ohm</td>
</tr>
</tbody>
</table>

Tip: If the UCI is connected to the Chromeleon server PC by a LAN connection, the ground connection of the UCI is potential free (contrary to a USB connection). With some detectors, this may affect the analog signal quality. To connect the UCI ground to the detector ground, connect the (green) Digital GND wire of the signal cable to the respective detector ground.
8.3 Digital Inputs

![Digital inputs (9-pin D-Sub female connector)](image)

<table>
<thead>
<tr>
<th>Pin</th>
<th>Port</th>
<th>Signal Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Input-1</td>
<td>TTL</td>
</tr>
<tr>
<td>2</td>
<td>Input-2</td>
<td>TTL</td>
</tr>
<tr>
<td>3</td>
<td>Input-3</td>
<td>TTL</td>
</tr>
<tr>
<td>4</td>
<td>Input-4</td>
<td>TTL</td>
</tr>
<tr>
<td>5</td>
<td>Input-5</td>
<td>TTL</td>
</tr>
<tr>
<td>6</td>
<td>Input-6</td>
<td>TTL</td>
</tr>
<tr>
<td>7</td>
<td>Input-7</td>
<td>TTL</td>
</tr>
<tr>
<td>8</td>
<td>Input-8</td>
<td>TTL</td>
</tr>
<tr>
<td>9</td>
<td>Ground</td>
<td>GND</td>
</tr>
</tbody>
</table>

**Tip:** Internal device resistors keep the digital input level at +5 V (pull-up resistance). Therefore, it is possible to use a contact closure relay, without an additional voltage source. This closure has to be installed between GND and the respective digital input. Once the relay is shut, the digital voltage is grounded.

The relay is under a low current of about 50 µA. If the signal source is active, that is, emitting voltage, verify the correct polarization of the digital input. The ground of the signal source must be connected to the ground of the UCI. The digital output of the signal source must be connected to the digital input of the UCI.
8.4 RS-232 Ports

![Fig. 20: RS-232 port (9-pin D-sub connector)](image)

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal Name</th>
<th>Signal Level</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DCD</td>
<td></td>
<td>Not used</td>
</tr>
<tr>
<td>2</td>
<td>RX</td>
<td>RS232</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>TX</td>
<td>RS232</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DTR</td>
<td>RS232</td>
<td>active (+10V, Ri=2,7kΩ)</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>GND</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>DSR</td>
<td></td>
<td>Not used</td>
</tr>
<tr>
<td>7</td>
<td>RTS</td>
<td>RS232</td>
<td>Hardware handshake</td>
</tr>
<tr>
<td>8</td>
<td>CTS</td>
<td>RS232</td>
<td>Hardware handshake</td>
</tr>
<tr>
<td>9</td>
<td>RI</td>
<td></td>
<td>Not used</td>
</tr>
</tbody>
</table>
8.5 BCD Inputs (Sample Position Recording)

![Fig. 21: BCD inputs (25-pin D-sub female connector)](image)

If the marked wire of a flat ribbon is connected to pin no. 1 of the female connector, the wires of the flat ribbon are numbered as follows:

<table>
<thead>
<tr>
<th>Pin</th>
<th>Wire</th>
<th>Port</th>
<th>Signal Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>BCD-1A</td>
<td>TTL</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>BCD-1B</td>
<td>TTL</td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td>BCD-1C</td>
<td>TTL</td>
</tr>
<tr>
<td>4</td>
<td>7</td>
<td>BCD-1D</td>
<td>TTL</td>
</tr>
<tr>
<td>5</td>
<td>9</td>
<td>GND</td>
<td>GND</td>
</tr>
<tr>
<td>6</td>
<td>11</td>
<td>BCD-2A</td>
<td>TTL</td>
</tr>
<tr>
<td>7</td>
<td>13</td>
<td>BCD-2B</td>
<td>TTL</td>
</tr>
<tr>
<td>8</td>
<td>15</td>
<td>BCD-2C</td>
<td>TTL</td>
</tr>
<tr>
<td>9</td>
<td>17</td>
<td>BCD-2D</td>
<td>TTL</td>
</tr>
<tr>
<td>10</td>
<td>19</td>
<td>GND</td>
<td>GND</td>
</tr>
<tr>
<td>11</td>
<td>21</td>
<td>GND</td>
<td>GND</td>
</tr>
<tr>
<td>12</td>
<td>23</td>
<td>GND</td>
<td>GND</td>
</tr>
<tr>
<td>13</td>
<td>25</td>
<td>GND</td>
<td>GND</td>
</tr>
<tr>
<td>14</td>
<td>2</td>
<td>BCD-3A</td>
<td>TTL</td>
</tr>
<tr>
<td>15</td>
<td>4</td>
<td>BCD-3B</td>
<td>TTL</td>
</tr>
<tr>
<td>16</td>
<td>6</td>
<td>BCD-3C</td>
<td>TTL</td>
</tr>
<tr>
<td>17</td>
<td>8</td>
<td>BCD-3D</td>
<td>TTL</td>
</tr>
<tr>
<td>18</td>
<td>10</td>
<td>GND</td>
<td>GND</td>
</tr>
<tr>
<td>19</td>
<td>12</td>
<td>BCD-4A</td>
<td>TTL</td>
</tr>
<tr>
<td>20</td>
<td>14</td>
<td>BCD-4B</td>
<td>TTL</td>
</tr>
<tr>
<td>21</td>
<td>16</td>
<td>BCD-4C</td>
<td>TTL</td>
</tr>
<tr>
<td>22</td>
<td>18</td>
<td>BCD-4D</td>
<td>TTL</td>
</tr>
<tr>
<td>23</td>
<td>20</td>
<td>GND</td>
<td>GND</td>
</tr>
<tr>
<td>24</td>
<td>22</td>
<td>GND</td>
<td>GND</td>
</tr>
<tr>
<td>25</td>
<td>24</td>
<td>GND</td>
<td>GND</td>
</tr>
</tbody>
</table>
**Tip:** Internal device resistors keep the digital input level at +5 V (pull-up resistance). Therefore, it is possible to use a contact closure relay, without an additional voltage source. This closure has to be installed between GND and the respective digital input. Once the relay is shut, the digital voltage is grounded.

The relay is under a low current of about 50 µA. If the signal source is active, that is, emitting voltage, verify the correct polarization of the digital input. The ground of the signal source must be connected to the ground of the UCI. The digital output of the signal source must be connected to the digital input of the UCI.

### 8.6 Power Receptacle

![Fig. 22: DC input]

9 to 18 Volt DC
9 Index

A
Accessories
  Optional ........................................................ 47
  Standard ........................................................ 47
Analog Inputs ................................................... 8
  Commands/Properties ..................................... 35
  Configure .................................................... 32
  Pin Assignment ............................................. 49
  Technical Data .............................................. 45

B
BCD Inputs .......................................................... 9
  Configure ...................................................... 33
  Pin Assignment ............................................. 52

C
Chromeleon ........................................................ 10
  Error Messages .............................................. 37
  Server Monitor ........................................... 13, 27
  CmiIPUtil .......................................................... 21
  Commands (Chromeleon) .................................. 35
  Configuration ................................................. 5, 28
  Analog Inputs ............................................... 32
  BCD Inputs ................................................... 33
  Digital Inputs ................................................ 33
  Network Operation ........................................ 21
  Separate Network Card .................................. 17
  Control Elements ............................................. 6

D
Demo (Dialog Box) .............................................. 30
Demo Chromatogram .......................................... 30
Demo Mode ..................................................... 28, 30
Dialog Box
  Demo ............................................................. 30
  General .......................................................... 28
Digital Inputs .................................................. 8
  Configure ...................................................... 33
  Pin Assignment ............................................. 50
  Technical Data .............................................. 45
Digital Outputs ................................................... 8
Display ................................................................. 6

E
Ethernet ................................................................. 8

F
Firmware Download ........................................... 28, 43
Firmware Update ............................................. 28, 43
Found New Hardware Wizard ................................. 14

G
General (Dialog Box) ........................................... 28

I
Installation ......................................................... 11
  Configuration ................................................ 28
  Connect ......................................................... 12
  in Chromeleon .............................................. 27
  LAN .............................................................. 15
  More than one UCI ........................................... 31
  Separate Network Card ................................... 16
  USB .............................................................. 13
  Instrument LAN ............................................. 16
  Integrator Driver ........................................... 32
  Intended Use ................................................... 3
  IP Properties .................................................... 21

L
LAN ................................................................. 8
  Installation ..................................................... 15
  Instrument LAN ............................................. 16
  Interface ......................................................... 5
  Peer-to-Peer Connection .................................. 16
  LAN Timeout .................................................. 29

M
Main power receptacle ........................................ 9
  Maintenance ................................................... 43
  Module Address ............................................. 29

N
Network Operation .............................................. 24
  Configure .................................................... 21
  Instrument LAN ............................................. 16
  IP Properties ................................................... 21
  Peer to Peer Connection .................................. 16
  Recommendations ......................................... 26
  Network Traffic ............................................. 24
Operating Instructions ......................................... 1
Operation ................................................. 6
Control Elements ........................................ 6
Pump Display ............................................. 6
Safety Precautions ...................................... 3

PC Interfaces ...................................................... 45
Peer-to-Peer Connection .................................... 16
Pin Assignment ........................................... 49
  Analog Inputs ......................................... 49
  BCD Inputs ............................................ 52
  Digital Inputs ......................................... 50
  RS-232 Ports ........................................ 51
Power ................................................................. 53
Power Receptacle ........................................ 53
Properties (Chromeleon) .................................. 35
Puffer Time .................................................... 25

Rear Panel ....................................................... 7
Rear Panel Connector .................................... 7
Relay Outputs ............................................. 8, 33
  Outputs (Technical Data) .......................... 45
Relays Commands/Properties .......................... 36
Remote Inject ............................................. 33
RMA Number .................................................. 43

RS-232 Ports ...................................................... 9
Assign ......................................................... 35
Pin Assignment ........................................... 51
RS-232 Ports (Technical Data) ......................... 45

Safety ................................................................. 2
Safety Precautions .......................................... 3
Sample Position Recording ............................. 9, 52
Server Configuration ..................................... 31
Service ......................................................... 43
  Firmware Update ...................................... 43
  Shared Device ......................................... 33
  Shared Relays and Inputs .......................... 33
  Site ......................................................... 11
  Spare Parts ............................................. 47
  Specification .......................................... 45
  Status Indicator ....................................... 6
  Symbols .................................................. 2

TCP/IP ............................................................... 24
Troubleshooting ........................................... 37
TTL Inputs (Commands/Properties) ..................... 36

Unit Description (Overview) ............................. 5
Unpacking ..................................................... 11
USB ................................................................. 8
  Installation .............................................. 13
  Interface ................................................. 5
  USB Configuration File .............................. 14